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LAB UNIT 2:  Electrostatic Force Microscopy (EFM) 
Specific Assignment:  Electrical Properties of Conjugated Polymer Films 
 
Objective  This lab unit introduces Electrostatic Force Microscopy to 

characterize the electrical properties of a blended 
conjugated polymer film by studying the changes in tip 
oscillation due to electrostatic force gradients between the 
tip and the sample. 

 
Outcome Learn the basics of electrostatic force microscopy, applying 

concepts including Coulomb force, capacitance, force 
gradients and damped driven simple harmonic motion.   

 
Synopsis We learn the basics of electrostatic force microscopy by 

characterizing a thin film composed of a blend of electron-
donating and electron-accepting organic semiconductors.  

  
Materials Thin film of 4:1 PCBM:MDMO-PPV on gold 
 Gold film 
 Indium tin oxide-coated glass 

  
 Tweezers 
 Alligator clip mounted on a glass slide 
 Alligator clip-terminated wire (both ends) 
 Voltmeter 
 Pair of small magnets 
  

Easy Scan 2 AFM system  
Pt-coated non-contact mode EFM tip with 1–5 N/m spring 
constant (probe model: ANSCM-PT from AppNano) 

 
Technique Intermittent-contact mode AFM imaging, electrostatic force 

microscopy (EFM) 
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1. Assignment  
 
The assignment is to learn about the basic concepts of electrostatic force microscopy, 
apply them to measure surface potentials and to characterize a phase-separated blend of 
conjugated polymers as might be done in studying organic solar cells. 

1. Familiarize yourself with the background information provided in Section 4. 

2. Test your background knowledge with the provided Quiz in Section 2. 

3. Prepare a grounded sample of a conductive polymer blend, evaporated Au and 
ITO for EFM as instructed in Section 3. 

4. Perform topographical, electrostatic measurements and study the phase shift as a 
function of applied bias as instructed in Section 3. 

5. Fit a function to collected data to determine the work function difference between 
indium tin oxide (ITO) and Au. 

6. Finally, provide a written report discussing the following results: 

(i) What is the Q factor of the tip you used?  Include a graph of the frequency 
sweep and corresponding phase shift.   

(ii) Using the phase shift versus voltage plots for ITO and Au, fit the data to 
the following function (just like PreLab Question 2): 

))(arcsin()( 2
0VxAxf −−=  

What value of V0 do you get for each metal?  Calculate the difference in 
work function between ITO and Au. 

(iii) Include the topography image and the EFM images of the surface: arrange 
them by increasing distance from the surface.   

(iv) What is the maximum variation in height (look at your topography scan)?  
How does this value compare to the changes in the phase contrast at 
different heights? 

(v) What causes the contrast in the EFM scans (ie, what physical property are 
you measuring?)  How does the contrast change as you increase the tip-
surface distance?  

(vi) How does the EFM image compare to the topographical image?  What 
might this say about the polymers? 

(vii) What are the limitations of this method of EFM?  How might you improve 
the experiment? 
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2. Quiz – Preparation for the Experiment 
Theoretical Questions 

(1) Derive the expression for the amplitude and resonance frequency of a damped, 
driven simple harmonic oscillator with damping constant b and natural 
frequency ω0.  (See Section 4.) The following steps will guide you: 

a. Give the differential equation describing the motion of a damped, driven 
simple harmonic oscillator.  What do each of the variables represent? 

b. In the text, we give the form of the solution for z(t).  Plug this into (a).  
Group the terms into a cos ωt and a sin ωt term.  For this equation to be 
true at all t, both terms must be 0,  i.e. the prefactors of these two terms 
must go to zero independently. 

c. Using the prefactor for the sin ωt, solve for the phase shift, δ.   
d. Using the prefactor for cos ωt, solve for A, the amplitude of oscillation as 

a function of frequency. (Hint: To get the expression into the form given 
in the text, remember that if tan x = a/b, then sin x = a/√(a2+b2).) 

e. For what driving frequency ω is the amplitude of oscillation the greatest?  
(Hint: Find ω for which A has a local maximum.)  This is the resonance 
frequency ωR. 

f. Assume that the damping factor is very small, so ωR ≈ ω0. What is the 
phase shift between the driving force and the oscillator response at this 
frequency? (Your answer should be an actual number.) 

 
(2) Write down the functional forms for the distance dependence of 

van der Waals (vdW) and Coulomb forces.  Do these forms explain why 
electrostatic forces can still affect the tip motion at ranges where vdW forces 
cannot? Explain. 
 

(3) Consider a simple parallel plate capacitor consisting of two circular plates 200 nm 
in diameter, spaced 50 nm apart. 

a. What is the capacitance of this structure? 
b. If this capacitor is charged to 5 V, what is the charge on each plate? 
c. How much energy is stored in the capacitor? 
d. What is the force acting between the capacitor plates when they are 

charged to 5 V? 
 

(4) Write a description in words explaining what is meant by the quality factor, or 
”Q” of an oscillator.  Write down at least three different formulas for determining 
the Q of an oscillator. 
 

(5) In an ideal instrument the minimum detectable force is limited by the thermal 
noise in the cantilever motion.  In this case the minimum detectable force gradient 

is 2
0

4'
AQ

TBkkF B

ω
= (where kB  is Boltzmann’s constant, T is the absolute temperature 
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(Kelvin), B is the measurement band, k is the spring constant of the cantilever, ω0 
is the natural frequency of the spring, Q is the quality factor of the resonance and 
A is the amplitude of oscillation).  What is the minimum theoretically detectable 
F’ for a typical cantilever operating at room temperature at B=1000 Hz? (Use k= 
1 N/m, ω0=30 kHz, A=1 nm, Q=100).  At what distance is the force gradient 
between two point charges comparable to this value? 

 
   

Prelab Quiz  
(1) Suppose you want to position the cantilever 75 nm above the surface 

in constant height mode.  What value should you type in the 
highlighted box? 

 
(2) Use the following data points into Excel (in the provided worksheet).  Fit the points 

with the following function: 
BVxAxf +−−= ))(arcsin()( 2

0   
Hint: Solve the equation for A(x-V0)2, then use Excel to fit the parabola.  The best fit 
to B is reasonably approximated by the maximum value of the phase shift. 
 
What value do you get for A?  V0? 
 
What physical quantity does V0 represent? 

 
(3) Given the following plot (see exact points in spreadsheet), find Q. 
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3. Experimental Assignment 
Goal 
Perform intermittent contact mode imaging and electrostatic force microscopy on a 
polymer blend sample.  Examine domains of PCBM and MDMO-PPV with both 
intermittent-contact SFM and EFM.  Find the difference in work function between ITO 
and gold. 

Materials 
Instrumental Setup 

- Easy Scan 2 AFM system with Pt-coated non-contact mode EFM tip with 1–5 N/m 
spring constant (probe model: ANSCM-PT from AppNano) 

- Alligator clip-slide holder 
- Alligator clip-terminated wire (both ends) 
- Pair of small magnets 
- tweezers (one for the EFM tip, one for the sample) 
- Samples: Au film, polymer film on Au film, ITO (see sample prep below) 

 
Sample Preparation 

- spin coater 
- sonicator (with acetone and isopropanol) 
- voltmeter with probes 
- thermal evaporator with gold (for the silicon/silicon oxide gold-coated substrate) 
- silicon/silicon oxide substrate with a thermally evaporated 15 nm gold layer 
- indium tin oxide (ITO) coated glass 
- poly[2-methoxy-5-(3’,7’-dimethyloctyloxyl)])-1,4-phenylenevinylene (MDMO-

PPV) 
- methanofullerene [6,6]-phenyl C61-butyric acid methyl ester (PCBM) 
- toluene 
- acetone 
- isopropanol 

    
 PCBM MDMO-PPV 

Safety 
- Wear protective gloves and safety glasses when working with solvents and the 

spin-coater 
- Review the Chemical Hazards below 
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- Refer to the General rules of the AFM lab  
 

Chemical Hazards:  This is only a summary of the Material Safety Data Sheets for the 
chemical reagents we will be using.    
 

Toluene: Flammable liquid and vapor. Causes eye, skin, and respiratory tract 
irritation. Breathing vapors may cause drowsiness and dizziness. May be absorbed 
through intact skin. Aspiration hazard if swallowed. Can enter lungs and cause 
damage.  Possible risk of harm to the unborn child. May cause central nervous 
system depression.  Target Organs: Central nervous system, respiratory system, 
eyes, skin. 
 
Isopropanol: Flammable liquid and vapor.  Irritant to eyes and skin.  Vapors can 
cause drowsiness or dizziness.  Target Organs: nerves and kidneys 
 
Acetone: Irritant, especially to eyes. Repeated exposure may cause skin dryness 
or cracking. Vapors may cause drowsiness and dizziness. Target organ(s): liver 
and kidneys 
 
MDMO-PPV  poly(2,5-bis(3',7'-dimethyloctyloxy)-1,4-phenylenevinylene 
PCBM ([6,6]-Phenyl C61 butyric acid methyl ester) 
These polymers have not been fully characterized for toxicity. 
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Experimental Procedure 
 
Reagent preparation 
(1) Prepare a ~10 mg/mL stock solution of MDMO in toluene.  This may take a few 

days and/or mild heating/stirring to completely dissolve. 
(2) Prepare a ~20 mg/mL stock solution of PCBM in toluene. 
(3) Mix a volume of 1 part MDMO and 2 parts PCBM.  The final weight ratio should 

be 4:1 PCBM:MDMO.   
 

Substrate preparation 
Substrates should be cut to a size that is small (to conserve materials), yet large 

enough to be handled easily.  A 1 cm x 1 cm square is a good size. 
 

(4) After cutting the substrate to size, sonicate both ITO slides and silicon/silicon oxide 
in an acetone bath, then an isopropanol bath for 20 minutes each 

(5) Blow the substrates dry with a nitrogen stream. 
(6) (Optionally, plasma clean the ITO for about 5 minutes.) Store the cleaned ITO in a 

covered container (petri dish) to keep it clean.   
(7) Evaporate about 15 nm of gold onto the silicon/silicon oxide substrates. 
(8) Set the spin-coater to spin at 2000 rpm for 30 seconds.  Gently deposit about 50 μL 

of 4:1 PCBM/MDMO-PPV (in toluene) onto the gold-coated substrate and start the 
spin-coater.  Reserve a gold-coated substrate for later use. 

 
Initial Set-Up of the Instrument 
See start up procedure in Easy Scan 2 AFM System SOP (Standard Operational 
Procedure) for more details. 
 
(1) Clip the polymer-film substrate into the substrate 

holder.  Set the voltmeter to measure resistance.  
Touch one probe to the conductive part of the 
substrate and the other probe to the alligator clip 
holding down the substrate.  A resistance of ~10-
15 Ω indicates a satisfactory contact has been 
made.  If not, gently push the clip down on the 
substrate, and wiggle the clip to “clean the 
contact” if necessary. 

(2) Load an EFM cantilever (k=1–5 N/m) into the AFM head. 
(ANSCM-PT tips) 

(3) Select the Operating Mode Panel: Select ANSCM-PT for the 
cantilever, and the Phase Contrast operating mode.  (If the 
cantilever option is not there, go to Options > Cantilever 
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Options, create a new cantilever profile with the tip name, and enter in the 
properties for the ANSCM-PT cantilever.  Save, then select the tip in Operating 
Mode.)  

(4) Uncheck the auto start imaging under Approach Options in the 
Positioning Window 

(5) Make sure the AFM tip has enough clearance (>1 mm) for the 
substrate and glass slide before carefully sliding under the tip. 

(6) Anchor the glass slide to the translation stage with the small 
magnets. 

(7) Ground the sample by connecting the clip to the Nanosurf 
controller by the alligator-clip terminated wire. 

 

 
 

Non-Contact/Intermittent-Contact Imaging 
 

(8) In the Operating Mode Panel: Mode Properties, make sure the checkboxes for Auto 
set and Display sweep chart are checked. Tune the cantilever tip manually by 
clicking Set.  Note the shape of the response curve (cantilever amplitude versus 
driving frequency).  

 Click on the graph, then save the data from the resonance curve (File > Export > 
Current Chart… and save as a Comma Separated z-Values (*.CSV) file).   You 
will need this later to determine the Q-factor for your cantilever. 

Examine the oscillation amplitude as a function of drive frequency and record the 
resonant frequency of your cantilever (shown grayed out in 
Mode Properties: Vibration frequency). 

(9) Quickly advance the tip closer to the surface by clicking and 
holding down on the Advance button in the Approach panel.  
Approach the tip to the surface by clicking on ‘Approach’ in the 
Approach panel. 
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(10) In the Imaging Panel, adjust the image width to image a 10 μm 
wide square on the sample, and check that the other parameters 
are set to the same as the image on the right.  Click Start to start 
the scan.  As you scan, make sure you have a relatively “flat” 
region of the sample. If the line trace appears crooked, use the 
menu option: Script > Imaging – Adjust Slope to straighten it out. 
Repeat for Rotation: 90º. Large pieces of dirt will adversely 
affect the EFM imaging in the next step. 

(11) Once you have scanned a region that is mostly free of dirt, click 
photo to save the image when the scan is done.  Allow the scan to 
finish.  When the window pops up with the completed image, 
click on the image, then File > Export, and save it as a Windows 
Bitmap Image (*.BMP).   

(12) We will choose a smooth subsection of this region to perform EFM.  Click on Zoom 
in the toolbar above, and draw a box (try for about 2 μm) around the cleanest 
region.  The Tool Results Panel will pop up on the left as you do.  Click Zoom to 
confirm your selection. 

(13) Obtain a topography image of this narrowed region. Check that you have a good 
saved image and area.  If the height variation is bigger than 50 nm, image a new 
area.  Once you have a good image you can stop imaging, by clicking Stop. 

 
 

Electrostatic force microscopy 
 

(1) We need to rearrange the chart window to show EFM data.  From the toolbar (shown 

above), click  to create a new display graph. Choose  to show a 

2D graph, and select  as the data to be shown.  Add yet another display, 

except choose:  to make a line graph of the 
phase data. 

(2) In the Imaging Panel: Imaging Modes, set Rel. Tip_Pos to –150 nm.  This is the 
distance that the EFM will withdraw from the surface during the measurement, i.e. 
the tip will retract 150 nm above the surface from the initial “contact” point.   You 
should know if the current spot is “clean” from the topography scan you just did.  If 
there are features taller than 50 nm (most likely dirt), NanoSurf will not remember 
they are there, and try to run the tip through them when we scan at lower heights. 

(3) Set the tip bias to 5 V, in Z-Controller Panel: Tip Properties. 
(4) Check the Const.-Height mode to start EFM measurements. 
(5) Click Start in the Imaging Panel and watch the phase map.  Let the AFM scan for a 

few lines up (at least 1/5 of the total image area). Do you see any contrast?  Move 
the tip closer to the surface by 25 nm.  Keep decreasing the tip-to-substrate distance 
(be careful not to go below –50 nm).  How does the contrast change?   Save this 
scan when it completes.  
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(6) Once you find a good distance for contrast, scan the entire area at the same height.  
Make sure to select photo to save the image when it is done scanning.   

(7) Recall the height variation you observed in the AC mode topography scan.  Increase 
the tip-sample distance by half this value, and reimage the area.  Save the image.  
Increase the distance again by the same amount, and obtain another scan of the area. 

(8) When you are done, reset the tip voltage to 0 V. 
 
“Calibrating” the EFM scan  
(9) Withdraw, retract the tip, and then carefully raise the AFM head 

from the sample. Switch samples to the gold substrate. 
(10) Approach the surface. As before, make sure Autostart Imaging 

is not checked. 
(11) Click on Spectroscopy in the left panel. Change the Modulated 

Output to Tip voltage.   
(12) Configure the display panel to show Phase, as before.  Use only 

the line graph, and display Raw Data. 
(13) Select Const-Height mode, in the Imaging Panel, and set the 

distance to –70 nm. 
(14) In the Spectroscopy: Measurement panel, change the number of 

averages to 20. 
(15) Click on Start.  If the shape that emerges is not a downward-facing parabola, first 

check that the substrate is firmly grounded.  Alternately, withdraw the tip, move to 
a new location and repeat.  You may also want to approach the tip to the surface to 
dissipate any charges collected on the tip.  You will have to reselect Constant 
Height Mode after doing so. 

(16) Save the trace, and repeat 4 times. 
(17) Repeat with the ITO substrate, or try other conductive surfaces. 
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4. Background: Intermittent-Contact Mode Force 
Microscopy & Electrostatic Force Microscopy (EFM) 

 
      Table of Contents: 

Motivation ........................................................................................................................................... 52 
Simple Harmonic Motion .................................................................................................................... 52 
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Electrostatic Force Microscopy ........................................................................................................... 55 
Applications ........................................................................................................................................ 56 

 

Motivation 
Contact mode, non-contact mode, and intermittent-contact mode scanning probe 

microscopy (SPM) all use short range van der Waals forces to probe the topographic 
features of a sample.  However, if we move the scanning probe further away from the 
surface (~20-60 nm), we can examine longer range forces, such as electrostatic and 
magnetic forces.  In doing so, we can learn about the electrical properties of a material 
with high spatial resolution.  Electrostatic force microscopy (EFM) and its variants are 
used to study topics as diverse as dopant profiles in silicon transistors, charge injection 
in organic diodes, and changes in photosensitive reaction complexes in biological 
membranes.  Both intermittent-contact mode and EFM make use of the changes of the 
motion of an oscillating tip to produce images.  In order to understand these imaging 
modes we first need to review the motion of an oscillating tip.  If you have studied 
simple harmonic motion in your physics or math classes, the next section may be 
familiar to you. 
 

Simple Harmonic Motion 
The SPM tip sits at the end of a long, flexible 

cantilever. This cantilever is flexible and behaves like a 
spring: if the tip is pushed in one direction the cantilever 
exerts a force in the opposite direction in an attempt to 
restore the tip to its original position.  Since we are going 
to be examining the motion of the tip in more detail, we 
first define some parameters: 

 
z(t)  position of the tip as a function of time 
F force exerted on the tip 
m mass of the tip 
k effective spring constant of the cantilever 
 

Remember that the velocity v(t) and acceleration a(t) of the tip are related to its position 
z(t) through the following derivatives: 
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dt
dztv =)(   2

2

)(
dt

zd
dt
dvta ==  

 
Newton’s third law (F = ma) relates the forces on the tip to its motion.  We already 
mentioned that the cantilever behaves much like a spring, and will we approximate the 
restoring force using Hooke’s law relating spring constants and restoring forces (F = –
kz). Combining these two equations gives us the following equation of motion: 
 

kz
dt

zdm

kzmaF

−=

−==

2

2  

  
The tip and cantilever are real materials moving through air, so the motion is also 
damped by both air friction and by losses in the spring.  These losses are both 
approximately proportional to the velocity and so we modify our equation of motion 
with a “drag force” or damping term –bv: 
 

dt
dzbkz

dt
zdm

bvkzmaF

−−=

−−==

2

2  

 
Rearranging a bit, we can write this as a differential equation describing basic motion of 
the tip far away from any substrate (and still without any driving force yet either) 
 

0

0

2
02

2

2

2

=++

=++

z
dt
dz

dt
zd

kz
dt
dzb

dt
zdm

ωβ
 

 
where ω0

2≡ k/m and β ≡ b/m.  ω0 is the natural frequency of the cantilever.   
 
Most non-contact/intermittent contact SPM is performed while applying a 

sinusoidally oscillating drive force on the tip, so we must also add the driving force to 
our equation of motion: 

tDz
dt
dz

dt
zd ωωβ cos2

02

2

=++  

 
This equation may look familiar.  It is the classic equation for the damped and driven 
simple harmonic oscillator.  The solution to this equation is a steady-state motion of the 
system should oscillate with the driving force, plus a potential phase shift δ.  You can 
check that the solution has the form: 
 

)cos()( δω −= tAtz  
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 where: 

⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
−

= −
22

0

1tan
ωω

ωβδ  

 
The amplitude, A, of oscillation is: 

22222
0 )( βωωω +−

=
DA  

 
The “resonance frequency” of the oscillator is defined as the driving frequency at which 
A is maximized.  If the damping is small, the amplitude is at a maximum when the 
driving frequency equals the natural frequency ω0.  The amount of damping in a simple 
harmonic oscillator is commonly characterized by the quality factor, Q.  Q is defined as 
the resonance frequency divided by β, and is a measure of the total energy stored in the 
oscillator divided by the energy lost per period of oscillation. For systems that are only 
weakly damped (like an AFM tip vibrating in air), a practical method of determining Q 
is to divide the resonance frequency by the width of the resonance peak (where the width 
is taken at the points where the amplitude is equal to 707.02/1 ≈ of the maximum). 

AC-Mode Imaging 
In a common form of topography imaging, called intermittent-contact mode (or a 

variation called “Tapping Mode™” by some manufacturers), the AFM is driven at a 
frequency close to the resonant frequency of the tip.  When the tip comes close to the 
surface, it interacts with the surface through short range forces such as van der Waals 
forces.  These additional interactions change the resonance frequency of the tip, thereby 
changing the amplitude of oscillation and its phase lag.  Typically, an image is formed 
by using a feedback loop to keep the oscillation amplitude constant by varying the tip 
sample distance with the z-piezo (see figure below).  By plotting the z-piezo signal as a 
function of position it is then possible to generate an image of the height of features on 
the surface.  It is possible to image in both the attractive, and the repulsive regions of the 
van der Waals potential, and strictly speaking this divides the classification of AC-Mode 
imaging techniques into “non-contact” and “intermittent contact” AFM respectively).  
However, intermittent contact AC-mode imaging is more common for routine imaging. 

 
Schematic for intermittent-contact mode AFM. (A) The AFM tip is driven near its natural resonance 
frequency to obtain a target amplitude of oscillation.  (B) As the tip approaches changes in topography, the 
increasing van der Waals forces shift the resonance frequency, which causes the tip’s oscillation amplitude 
to decrease.  In response, the Z-piezo lifts the tip away from the surface so (C) the original oscillation 
amplitude is reestablished.  By tracking the Z-motion of the tip, we obtain the measured topography of the 
surface (dashed line). 
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Of course, the material properties of the sample affect tip-surface interactions, so 

the topography image obtained by AC-mode imaging isn’t perfectly free of artifacts 
(some imaging modes even exploit differences in elastic properties of the surface to 
differentiate materials).  Nevertheless, AC-mode imaging is much gentler and can be 
used to image a wider variety of soft samples than contact mode imaging. 
 

Electrostatic Force Microscopy 
The goal of an EFM experiment is not to image the surface topography, but 

rather to image the electrical properties of the surface.  This is accomplished by vibrating 
a metal-coated tip some distance away from the surface — beyond the range of short 
range van der Waals interactions, so that only long-range forces 
(such as electrostatic forces) remain. 

 As the tip scans over a surface, its motion is affected by 
the forces between it and the surface below.  To understand EFM, 
it is useful to think of the tip and sample as forming two plates in a 
very small capacitor.  The potential energy, U, of a capacitor with 
capacitance C charged to a voltage V is given by: 

 
2

2
1 CVU =  

 
The force F, is always given by the first derivative of the potential U, as a function of 
position z. The force between the tip and the cantilever is then: 
 

22

2
1

2
1 V

dz
dCCV

dz
d

dz
dUF −=⎟

⎠
⎞

⎜
⎝
⎛−=−=  

 
This force depends on both the applied voltage (independent of distance) and the 
capacitance (depends on distance).  This is really an electrostatic force (Coulomb’s Law) 
in a different form.  The potential difference causes opposite charges to build up on the 
tip and the substrate (as seen in the cartoon), which pulls the tip towards the substrate.   

How does this force affect the tip motion? Well, to first order it doesn’t!   (You 
may remember from your physics coursework that the resonant frequency of a spring-
mass oscillator doesn’t depend on the value of the local gravitational acceleration).  It is 
not the electrostatic force, but rather the force gradient that determines the oscillation of 
the tip.  For example, the force gradient using the restoring force from the cantilever 
(Hooke’s Law) is 

k
dz
dF

kzF

−=

−=
 

 
This is the spring constant, which shows up in the natural frequency ω0 of the oscillator.  
Any other forces on the cantilever that have a significant force gradient will affect the 
tip’s motion.  In this case, we are interested in measuring the electrostatic force by how 



LAB UNIT 2 
 

56 

it affects our oscillating tip.  It is easier to see the effect of this additional force on the 
tip’s motion by writing its contribution to the total force gradient: 

2
2

2

2

2
1
2
1

V
dz

Cdk
dz
dF

V
dz
dCkzF

−−=

−−=
 

Assuming 2

2

dz
Cd is relatively constant for the range of motion, we can consider this new 

factor as a change in the spring constant, kkk Δ+=′ .  In other words, the electrostatic 
force gradient works like a change in the effective spring constant of the cantilever.  
This will change the natural oscillation frequency, now ω0', and the phase shift δ' 
between the cantilever and drive signal for some constant driving frequency ω. 

⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
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For small damping factors and a driving frequency at the resonance frequency (ω0= ω), 
we can approximate the change in phase shift as [3]: 

⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
−=Δ 2

2

2

2
arcsin V

dz
Cd

k
Qδ  

In real experiments, the phase shift versus voltage curve has a non-zero offset, V0: 

⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
−−=Δ 2
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2
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2

arcsin VV
dz

Cd
k

Qδ  

This offset is attributed to the difference in work function between the tip and the 
sample. 

Applications 
 Electrostatic force microscopy and variations of EFM (such as scanning Kelvin 
probe microscopy (SKPM), measuring differences in surface potential; magnetic force 
microscopy (MFM), measuring magnetic moments) can be used to characterize many 
different samples, such as dopant profiles in silicon-based transistors, polarization in 
piezoelectric materials, and charge distributions in organic semiconductors.  In this lab, 
you apply EFM to characterize metal films as well as semiconducting polymer blends. 
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